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Treatment Pick List Window 

 

A Pick List or Associated Entries window has been created in AVImark and is designed to display linked 

entries and allow the user to pick those linked entries that are to be posted. This new window is accessible 

directly from Medical History. 

 

Auto-Prompting for Pick List 

This window can be automatically displayed at the time the parent entry is posted in Medical History.  

• Locate the desired service in the Treatment List and open the Change Treatment window. 

Remember that if you choose to use this on a group treatment the parent treatment does not 

get posted to Medical History, therefore you will not be able to access the Pick List window 

after closing the automated display.  

• From the “Associated Entries” tab link the desired entries and check the option “Prompt for 

Associated Entries”. You must check this option in order to access the Pick List window. 

Associated items will also be included in the Pick List window.  

• With this option checked the Pick List window will automatically open at the time the parent 

treatment is added into Medical History.  
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Utilizing the Pick List Window 

• Add the parent treatment in Medical History.  

• In the Pick List window choose the entries to post to Medical History by left-clicking on the 

entries, pressing the Spacebar or using right-click Select. For the number of times you left-

click on an associated entry or press the Spacebar, the dispensing quantity will increase for 

that entry. 

 

 
 

• The selected entries to be posted will appear at the bottom of the Pick List window and will 

only be posted to Medical History. Associated items will appear in Pick List and not 

Inventory Used.  

• When ready to post the selected entries click OK.  
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• To access the Pick List window from Medical History select the parent treatment and use 

right-click Choose, Pick List Entries.  
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Advanced Option for Abnormality Table 
 

A new Advanced Option can be used to copy notes from an abnormality in System Tables to the Medical 

Condition Record. 

 

• From Hospital Advanced Options search for “Copy Abnormality Notes to MCR” and set it to 

True.  Please note, setting this option to True will overwrite the default text for the Normal and 

Not Examined fields.  

• In System Tables select the Abnormality Table and on the desired entry choose right-click Notes 

to enter the desired notes. 

• Create a medical condition record and in the Objective area click on the appropriate abnormality 

with the attached notes. The notes will copy over and appear in the displayed note window.  
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Information Search “Is Payment” Search Option 
 
From the Accounting area of the Information Search a new field, Is Payments, has been added to allow 
for searching on Payments instead of using Accounting Type and listing all payment account types.  
 
The “Is Payments” option works for user specific and preset payments. “Is Payment" applies to these 
payment types as wells as custom payment types from system tables: P,C,V,M,D,E,O,$,H,% 
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Problem List E-Travel Sheet Action Code 

 

The Include on E-Travel Sheet action code has been added to the Problem List.  

 

• Use the <, Include on E-Travel Sheet, action code to display the selected problem on the E-Travel 

sheet.  
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Drug Refill Security Function 
 

A new security function has been implemented to control the changing of refill information in the Drug 

Label window.  

 

• As an Administrator access Users and Security 

• Secure the function INV19, Change Refill Information to allow only authorized users to change 

the refill options on a prescription that is being refilled.  
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ASAP Changes for Alabama 
 

The state of Alabama has requested two changes to the ASAP utility, these are listed below: 

 

• If no client date of birth or gender is entered, the patient’s date of birth and gender will now be 

reported. 

• If no client driver’s license number is entered, 000-00-0005 will now be generated on the report 

for the patient’s ID. 
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ASAP for Tennessee 
 

Clinics in Tennessee are now required to submit their Controlled Substances in ASAP 4.1 (2009) format. 

Because of this requirement the state of Tennessee has been added to the ASAP report utility.  

 

To begin generating the report for the State of Tennessee, you are required to: 

 

• Update to AVImark version 2012.1 or higher 

• Have your Hospital DEA number assigned on the Demographics tab in Hospital Setup 

• Assign your doctor DEA numbers in Users and Security 

• Make sure the AVImark items to be reported have the C Action code (denoting it as Controlled 

Substance) and the NDC number assigned 

• Have the “Include Sequence Number option for printing Drug Labels” set to True in advanced 

options 

o Printing prescription labels through AVImark will assign numbers and maintain them in 

sequential order. This number will be a unique Rx number that will be printed on the 

corresponding Drug Label, as well as being reported for that Controlled Substance line 

entry on the ASAP report. 

• Setup the Days Supply for the controlled substances. You will do this in the “Minimum Interval 

Between Refills” field, on the Pharmacy tab in the change item window of the controlled 

substance. 

• Have the animal’s birthdays and genders entered in the patient area. 

• Enter each doctor’s license number in users and security.  

 

To acquire the properly reported data for your state follow these steps: 

 

• From the AVImark CID select Utilities, Utilities and type in ASAP. 

• You will be prompted with a Backup option, if you currently do daily backups you can click No. 

If you would like AVImark to be backed up, click Yes. 

• In the ASAP utility, select the From date and Days to send. 

• For Export to, select the location to which you wish to export the file. For example, the C:[ ] 

option. 

• Select your state: Tennessee 

• Select the option Only report entries with label notes. If a Controlled Substance entry in 

Medical History contains drug label notes, only those entries will be reported when using this 

option. 

• Click Run. 

• When completed, you will find the .dat file at the location you selected.  You may then send this 

file to the proper authorities. 

10



ASAP for Hawaii 
 

Clinics in Hawaii are now required to submit their Controlled Substances in ASAP 4.1 (2009) format. 

Because of this requirement the state of Hawaii has been added to the ASAP report utility.  

 

To begin generating the report for the State of Hawaii, you are required to: 

 

• Update to AVImark version 2012.1 or higher 

• Have your Hospital DEA number assigned on the Demographics tab in Hospital Setup 

• Assign your doctor DEA numbers in Users and Security 

• Make sure the AVImark items to be reported have the C Action code (denoting it as Controlled 

Substance) and the NDC number assigned 

• Have the “Include Sequence Number option for printing Drug Labels” set to True in advanced 

options 

o Printing prescription labels through AVImark will assign numbers and maintain them in 

sequential order. This number will be a unique Rx number that will be printed on the 

corresponding Drug Label, as well as being reported for that Controlled Substance line 

entry on the ASAP report. 

• Setup the Days Supply for the controlled substances. You will do this in the “Minimum Interval 

Between Refills” field, on the Pharmacy tab in the change item window of the controlled 

substance. 

• Have the client’s date of birth in the client area, 

• Setup an additional client field for the client’s gender. 

• Enter each doctor’s license number in users and security.  

 

To acquire the properly reported data for your state follow these steps: 

 

• From the AVImark CID select Utilities, Utilities and type in ASAP. 

• You will be prompted with a Backup option, if you currently do daily backups you can click No. 

If you would like AVImark to be backed up, click Yes. 

• In the ASAP utility, select the From date and Days to send. 

• For Export to, select the location to which you wish to export the file. For example, the C:[ ] 

option. 

• Select your state: Hawaii 

• Select the option Only report entries with label notes. If a Controlled Substance entry in 

Medical History contains drug label notes, only those entries will be reported when using this 

option. 

• Click Run. 

• When completed, you will find the .dat file at the location you selected.  You may then send this 

file to the proper authorities. 
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Separating 1 Year and 3 Year Rabies Tag Numbers 
 

Clinics that are required to separate the 1 year and 3 year Rabies Tag numbers now have the ability to do 

so by utilizing new options in Hospital Advanced Options.  

 

• Access Hospital Advanced Options and search for rabies. 

• In order to begin separating the tag numbers you will need to set the option “Separate 1 Year and 

3 Year Rabies Tag Numbers” to True.  

• Set the starting numbers by using the options “Starting Number for 1 Year Rabies” and “Starting 

Number for 3 Year Rabies”.  After selecting the appropriate option click Change to define the 

value.  

 

The number(s) defined on the Advanced Options will be the first number assigned to the first tag 

administered after defining the options and then AVImark will auto-increment from that point forward.  

The reminder interval for the administered rabies treatment will determine if the rabies is a 1 year or a 3 

year.  

 

Note: When the new “Separate 1 Year and 3 Year Rabies Tag Numbers” option is set to True, AVImark 

will always look in advanced options for the next rabies tag number.  If a change needs to be made to the 

sequence, it should be changed in advanced options.  For example, the user needs to remove a rabies entry 

from a patient or the tag number changes, this number will need to be changed in advanced options 
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AVImark Compliance with MasterCard Partial Approval Mandate 
 

Applications integrated with X-Charge and MPS must support the mandate to ensure  

they are current with industry standards. 

Some key elements of supporting the mandate are: 

 

• Applications (AVImark) must support multiple tender/payments.   If the 

amount is partially approved, AVImark is required to prompt for additional 

tender, such as cash, check, or other credit card payment.  

• If the additional payment declines or is not possible or available, then the partial 

approval amount must be reversed. 

• Receipts must show the card Balance, if available and returned by X-Charge or MPS. 

• Integrations must be certified for the Partial Approval Mandate. 
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X-Charge Partial Approval Implementation 
 

AVImark has implemented the following changes in order to comply with the Mastercard Partial 

Approval for our X-Charge users. 

 

When taking a Mastercard payment (including Debit) that is only approved for part of the payment 

amount, the AVImark user will be alerted that a secondary form of payment is required to fulfill the 

payment amount.  The message is: 

 

 
 

Selecting Yes will present a new AVImark Enter Payment window allowing you to select the secondary 

form of payment to complete the transaction.  Both payments will be displayed on the AVImark Invoice 

as well as the available card balance, if balance information is returned by X-Charge. 

 
 

If a Debit Mastercard payment is taken there will be no signature line displayed on the Invoice. 

 

Selecting Cancel will remove/void the payment completely.  This option is recommended, in keeping 

with the mandate, to be used when a secondary form of payment is not available or has been declined.   

 

 

Selecting No will only place the partially approved payment amount into Accounting and on the Invoice 

with the remaining amount showing unpaid to the clinic. 
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Cubex Inventory Management System 
 

With the update to AVImark version 2012.1.0 you will be able to maximize the efficiency of your 

inventory management with our new integration with the Cubex System.  Communication is handled 

between the computer on the cabinet, myCubex web service, and AVImark. 

 

**Important Note:  Internet connection is required for this integration. 

 

To begin setting up the integration between your Cubex System and AVImark you will need the 

following in AVImark: 

 

-  An Excel report containing your Inventory List.   

o To generate the report select File > Print > Inventory List, from the Work With Inventory 

List. 

o Sort by Code. 

o Select Excel as your “Print To” option. 

o The completed Excel report can be provided to Cubex (support@cubexsystems.com) for 

cabinet software setup. 

 

 
 

-  An Excel report containing AVImark user group, name, and ID, information for all users that 

may be dispensing items from the cabinet.  This list can also be generated by AVImark in the 

following manner: 
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o Select Work With > Users and Security. 

o Highlight the desired category, then select View > Print. 

o Select Excel in the “Print To” field, and click Print. 

o The completed Excel report can be provided to Cubex (support@cubexsystems.com) for 

cabinet software setup. 

 

 
 

AVImark Advanced Options 

 

Open Advanced Options (wrench icon on the CID), and enter Cubex in the Search field.  You can set both 

default and site values as needed.  From here you will need to make the following settings: 

- Active – True 

- Password – Password as assigned by Cubex 

- Site Code – Assigned by Cubex 

- Use Cubex pricing when greater than zero – when set to True, if Cubex has a price for any item 

greater than 0.00, the Cubex price will be charged to the AVImark Medical History and 

Accounting.  If set to True, and the Cubex price for the dispensed item is 0.00, the AVImark price 

will be the amount billed in AVImark Medical History and Accounting.  With the option set to 

False, the AVImark price will be used for all Medical History and Accounting regardless of the 

price entered in the Cubex system. 

- User Name – Assigned by Cubex 

- XML Path – The user defined directory to house the XML file that will remain and be updated 

with each Cubex transaction data.  We recommend the directory be placed within the AVImark 

directory, and using this setup the value in Advanced Options will look like this:  Cubex 

Transactions (no backslash and folder is named Cubex Transactions). 

 

Feature Use 

 

 

There is a new automatic polling utility that will run on 30 second intervals to search for any new Cubex 

transaction data information.  This utility will be setup and set to run automatically simply by having 

Cubex Option set to Active.  The utility will be available to open and close manually if desired by 

accessing the new system tray icon that will be displayed when the utility is running.   
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To stop this utility manually, right click on the shaking hands and select close.  The utility is 

automatically set to open when AVImark opens and close when AVImark closes.  However, if you have 

unchecked the option to open when AVImark opens, and need to re-launch the utility, you can do so by 

selecting Utilities > Cubex Polling and the service utility will be restarted. 

 

 

When an AVImark patient has a checked-in status or has any new unposted entry created (such as a refill 

or treatment entry) in Medical History, they will become “Active” in the Cubex System and available to 

be selected for inventory distribution.  This communication uses an internet connection to transmit XML 

information between the systems.   

 

As items are needed from the Cubex cabinet, simply locate the appropriate active patient in the cabinet 

and enter dispensed information using the keypad.  The dispensing information will be queued by 

myCubex for retrieval by AVImark when the patient is released, checked-out, or posted to the AVImark 

Invoice and the patient will be de-activated in the Cubex system.   

 

If the qty/amount dispensed from the Cubex cabinet differs from the qty/amount entered into AVImark 

Medical History for that patient, the qty/amount from the cabinet is considered accurate and will 

overwrite the qty/amount in Medical History and be the qty/amount posted to the AVImark Accounting.  

The AVImark on-hand quantity for that item will also be updated to reflect the amount dispensed from 

the cabinet. 
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Intelligent Inventory 
 

Intelligent Inventory is designed to improve receiving accuracy. Ordering performed outside the 

AVImark system (Phone, Fax, Internet, etc.). The distributor passes order information they receive to 

Intelligent Inventory and AVImark retrieves the info and displays it in the system to make it available for 

receiving into the AVImark Inventory List. 

 

Creating Your Intelligent Inventory Account 

 

Clinics wishing to utilize the Intelligent Inventory integration within AVImark will need to do the 

following: 

• Register for an account at http://www.intelligentinventory.com to obtain your Gateway Account 

ID and credentials for using the site and connecting to the Gateway to retrieve purchase orders. 

• You will also need to have your account numbers your accounts with participating distributors. 

Important Note:  Please be aware of the distinction between your Gateway account ID (the ID that 

identifies you to Intelligent Inventory) and your distributor account ID (the ID that identifies you to 

Butler/IVESCO/MVS/etc).  

 

Setup 

 

1.  Install the IIGateway Service on the AVImark server: 

a. Run the IntelligentInventory.exe  self extractor (found in the AVImark folder)  to extract 

the contents into the AVImark folder.  This will create an IntelligentInventory subfolder 

within AVImark containing 12 files. 

b. Run the “Run Me.bat” file (found in the INtelligentInventory subfolder) to install the 

IIGatewaySvc. 

2. From the Services > Intelligent Inventory menu (on the AVImark CID), run the “Get Inventory 

Items” utility.  

3. Enter username/pw/gateway account number credentials provided by Impromed into Intelligent 

Inventory Configuration found in Services > Intelligent Inventory menu.  

4. While still in the Configuration window you can edit the distributor information with the proper 

Distributor Account Numbers (as assigned by your distributor).  You can edit existing displayed 

distributor information by selecting the appropriate line, and using the E button, or add new ones 

by using the + button. 

5. Start the IIGateway Service found in Windows Services (Start > Services) 

6. Set the designated workstation to “set auto process computer” found in AVImark Services > 

Intelligent Inventory. 

 

Advanced Options 

- Auto Process Incoming Purchase Orders – When set to True: This option will allow all Purchase 

Orders to be imported to the AVImark Inventory Purchase Order list automatically, provided all 

distributor items contained on that Purchase Order are mapped to an AVImark item. 

IMPORTANT:  AVImark clinics using the Site Feature will not be able to use the Auto Process 

Incoming Purchase Orders Option for the Intelligent Inventory feature at this time. 

 

- Computer GUID to Auto Process Intelligent Inventory POs – This will display the computer 

GUID for the workstation designated by having run the “Set Auto Process Computer” 

- Days Before Next Auto Catalog Update (0=do not auto run) –The number entered here will 

update the distributor's inventory automatically at the given day interval, unless the interval is 

zero. 
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- Last Catalog Update - Date the last update took place 

- Run Purchase Order Monitor 

 

Services Menu on CID 

 

- Get Inventory Items – This option will update the distributor's inventory.  This option performs 

the manual retrieval of data that occurs automatically when the Catalog Update takes place. 

- Review Purchase Orders - Opens the window displaying all available Purchase Orders containing 

items needing to be mapped to AVImark items and Imported. 

- Web Site - Launches the Intelligent Inventory site from within AVImark. 

- Set Auto Process Computer - Using this option on an AVImark workstation, will designate that 

workstation as the computer to be used for processing communications between AVImark and 

Intelligent Inventory. 

- Configure 

o PIMS Account Number 

o Gateway User Name 

o Gateway Password 

o Practice ID – This will be a globally unique, unalterable, identifier that will be 

automatically generated upon setup. 

o Distributor Information 

Important Note:  Your Butler Account Number contained in this field must end with the -000 suffix. 

 

 
 

 

 

Additions to Inventory List 

 

There are three areas within AVImark where users can cross reference or “map” distributor item codes to 

existing AVImark item codes. 

 

- Inventory List menu – RX Cross Reference > Intelligent Inventory 
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- Directly from the Change Item window: 
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- From the Import Purchase Orders window: 
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**Items displayed in bright yellow indicate the item has not yet been cross referenced with an 

AVImark item code. 

 

**If you have an item that you do not wish to cross-reference to an AVImark item, you can right-

click on that item and mark it as a non-inventoried item.   

 

 
 

You will receive a confirmation message: 
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The non-inventoried item will now be displayed with [NI] in the AVI # column in the Review 

Purchase Orders window and will not be included on the Purchase Order when imported. 

 

Should you decide you wish to change a previously designated non-inventoried item to have an 

AVImark item cross-reference assignment, you can do so by selecting that line item in the Review 

Purchase Orders window, and right-click to select “Remove non-inventoried designation”.  This will 

again allow you to assign your AVImark cross-reference. 

 

 

**Purchase Orders beginning with N indicate a New Order, and those beginning with U indicate an 

update to an existing Purchase Order.  If you attempt to Import a purchase order with a U prefix and 

haven't yet released the equivalent N order yet, you will receive this warning: Warning. Could not 

update this PO. Be sure released PO exists. When you Import the New and corresponding updated 

order, they will be merged as one order in the AVImark Purchase Order window for receiving. 

 

Feature Use 

 

Once your distributor item codes are associated to AVImark item codes, you are ready to begin 

automatically importing Intelligent Inventory Purchas Orders so you can receive the items into your 

AVImark Inventory List. 

 

Upon opening AVImark on the workstation set as the “Auto Process” computer, users could be 

prompted with a Catalog items prompt.  This workstation will also display an Intelligent Inventory 

Monitor window in the lower right corner of the screen indicating the number of purchase orders 

ready for review. 
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Purchase orders that contain a complete list of AVImark/Intelligent Inventory cross referenced items 

will be automatically imported to the AVImark Inventory List where they can be received/receipted 

as a typical AVImark generated purchase order.  

 

• To find this list, open the Inventory List, and select File > Order > Choose. 

 
 

This will display the list of imported purchase orders. 

 
 

• To receive the items into your AVImark Inventory List, either right-click > select, or double-

left click the appropriate order.  

• You should now be in the Purchase Order window displaying the details of the order to be 

received. 

• Select Order > Receive 
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• You will be presented with the following message: 

 
 

• Press OK and make any necessary adjustments. 

• Select Order > Receive again to complete the receipting process. 

 
 

• Press Continue. 

• You will now be back to the Purchase Order list window to process any additional purchase 

orders. 

The received items will be updated in the AVImark Inventory to indicate the item was received.  These 

areas include: 

o On Hand Qty 

o Purchase History 

o Last PO 

o Average Cost information 
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o BarCode information 

o NDC information 

 

One area that will not be updated is Expiration Date information. 

 

For Intelligent Inventory purchase orders that contain an item or items that have not yet been cross 

referenced with AVImark items, orders can still be imported and received.  To perform this cross 

reference and import the purchase order select Services > Intelligent Inventory > Review Purchase 

Orders. 

 
 

Once you make your cross reference assignments, you can proceed with Importing your order, and 

receiving it into your AVImark Inventory List when the order arrives. 
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ScilVet ABC + Ethernet Connectivity 
 

AVImark has improved connectivity options for the ScilVet ABC + by now also supporting Ethernet 

connectivity as well as Serial Port connectivity.  To connect to your ScilVet ABC + via Ethernet 

connection, please follow the instructions listed below. 

 

Once you have established your ABC + on your network, you can set it up in AVImark.   

 

Instrument Management 

 

• Select Services > Instrument Management. 

• Right-click, New and select Scil Vet ABC Plus 

• Select TCP Server as your Protocol. 

• Press Next. 

 

  
 

• Set Host to 0.0.0.0 

• Set Port to 4148 

• Press Finish 

 

Test results will be transmitted via the “Run Instrument Import” utility. 
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Analyzer Time/Date Displayed on Report 
 

AVImark will display the time and date on the result report when a blood analyzer returns the time/date of 

the test with result data. 
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AVImark Compliance with MasterCard Partial Approval Mandate 
 

Applications integrated with X-Charge and MPS must support the mandate to ensure  

they are current with industry standards. 

 

Some key elements of supporting the mandate are: 

 

• Applications (AVImark) must support multiple tender/payments.   If the 

amount is partially approved, AVImark is required to prompt for an additional 

tender, such as cash, check, or other credit card payment.  

• If the additional payment declines or is not possible or available, then the partial 

approval amount must be reversed. 

• Receipts must show the card Balance, if available and returned by X-Charge or MPS. 

• Integrations must be certified for the Partial Approval Mandate. 

 

 

MPS Partial Approval Implementation 

 

When taking a Mastercard payment that is only approved for part of the payment amount, the AVImark 

user will be alerted that a secondary form of payment is required to fulfill the payment amount.  The 

message is: 

 

 

 

Selecting Yes will present a new AVImark Enter Payment window allowing you to select the secondary 

form of payment to complete the transaction.  Both payments will be displayed on the AVImark Invoice. 
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Selecting Cancel will remove/void the payment completely from the invoice.  This option is 

recommended, in keeping with the mandate, to be used when a secondary form of payment is not 

available or has been declined.   

 

Selecting No will only place the partially approved payment amount into Accounting and on the Invoice 

with the remaining amount showing unpaid to the clinic. 

 

• The AVImark Invoice will print the card balance on the receipt, as shown below.   

In the case the card does not have a remaining balance the invoice will read- Balance Not 

Available  
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• Authorization Reversal - An authorization reversal is a real-time transaction initiated when the 

customer decides that they do not want to proceed with the transaction, or if the merchant cannot 

complete the transaction for any reason.  Authorization reversals free up the customer's available 

balance on their debit, prepaid or gift card. 
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Handling UNPROCESSED Payments 

- Deposit Slip Report: When a MPS credit card window is manually closed to prevent the 

payment from being logged, AVImark places a line in Accounting to show as UNPROCESSED.   

As of version 2012.1, AVImark now list these payments as UNPROCESSED on the Deposit Slip 

Report.     

 

- From AVImark Accounting window:  AVImark now allows the ability to remove 

UNPROCESSED from an Accounting Transaction line.  Hospital Administrators can secure this 

by assigning the security function ACT07 to the administrative group that has authority to enter 

UNPROCESSED payments into Accounting.  (Users authorized to ACT13)    

  

Once UNPROCESSED has been added into Accounting, in the case that the payment type needs 

to be changed, AVImark allows the user to manually change this transaction line by doing right-

click Change and selecting Cash, Check or another card.   

Example of when this is necessary:  

1.  If the internet is down the clinic can choose to leave record of the payment in 

accounting as UNPROCESSED.  

2.  When the internet comes back on, authorized users can right-click Change and 

select the correct card, Cash or Check.  

Once the transaction IS processed AVImark allows the following:       

1. Allows the UNPROCESSED line to be changed.   

2. Changes the color of the entry in Accounting from green to black. 

3. Records the change in Accounting Entry History of the payment to show 

that it was originally unprocessed and someone processed the transaction 

manually.  

4. Displays correctly on the Deposit slip so the payment isn’t allowed to 

show as UNPROCESSED.    
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Miscellaneous MPS Enhancements 

 

• The MX850 integration now prevents the total from having to be verified when hand keying a 

card; it still requires a signature from the client. 

 

• When hand keying a transaction, once the month field is populated by entering 2 digits, the year 

field is now automatically tabbed to and highlighted for easier entry.   

 

• AmEx card verification has been increased to look at the first TWO digits of the card and will 

now allow the “change type” to work appropriately. 
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2012.1 Fixes List 
 

 

Accounting: 

3375 - Two Invoices Being Created 

If two users, on two different computers clicked close on an invoice at the exact same time on the same 
client, two invoices were being created; one was a blank invoice. 
 
 
Additional Data Fields: 

3247 - Cannot Cancel Additional Data Field if No Name is Entered 

If a name is not entered, for an additional data field, clicking cancel caused the following message: 
“Named is a required field. Please enter a name.” 
 
2100 - Error when More Stuff Name is Data 

When the name of a more stuff entry on a treatment was Data, and the treatment was put into medical 
history, the following error was being displayed: "Invalid property type, named Data for GetAsVariant." 
 
830 - Canceling "Normal" Window Throws an Error 

Canceling the “Enter Normal Value” window was causing the following error: “Error. Record, Normals 
Entry, record number, -1, record state, New. Destroying modified object.” 
 
 
Appointment Calendar: 

1257 - Getting Message that Appointment is on a Scheduled Blockoff, when Exception has Been 

Made 

When a blockoff had been scheduled, but an exception was created; attempted to create a an appointment 
in the exception timeframe was causing the following warning: “Appointment is on a scheduled block off. 
Please change the appointment's date or time.” 
 
3227 - Blockoff Exception Included on Appointment Schedule 

When a blockoff exception was added to a blockoff, and the appointment schedule was printed, the 
blockoff was still being printed on the appointment schedule. 
 

3124 - On the Fly Blockoffs for ALL Doctors Not Printing 

If a new On the Fly blockoff was created for ALL doctors, and the appointment calendar was printed for 1 
doctor, this blockoff was not being included. 
 
2051 - Adding Services to Linked Appointments 

When creating a linked appointment, users were not allowed to add services until clicking Done then 
going back to the appointment. 
 

1806 - Column Not Holding When Changing Days 

In the Daily by Doctor view, scrolling over to view a different doctor then changing days was not holding 
the same screen position. 
 

729 - Selecting Treatments in the Appointment Reservation Window Does Not Update the 

Appointment Time Duration Appropriately 

If an appointment is made and a service is added that would cause the appointment to last longer than the 
normal duration, the appointment duration was not updating correctly. 
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622 - Appointment Option Needs Removed Under the Client Area 

In the information search, there was an appointment area that has been removed. 
 
1081 - Access Violation in Weekly By Room View 

When creating a block off exception for one room and using the weekly by room view following error 
was generated: "Access violation at address 20004D50 in module 'rtl100.bpl'. Read of address 00000008" 
 

902 - Blockoff Propagate to These Dates was Not Working Correctly for Blockoffs 

 

1522 - Printing Appointment Calendar to Excel 

When printing the appointments to Excel, the hospital information was being printed above each 
appointment and line break. 

 

1611 - Removing Blockoffs 

With APT07, APT08, and  APT09 secured, unauthorized users will be stopped from creating blockoff 
exceptions by right click remove. 

 

3123 - Appointment Groups Option Always Showing in Default View 

The Appointment Groups option will only be available in the Daily by Doctor view. 

 

3427 - Blockoff Alerts Coming Up on Schedule Tab 

If an on the fly blockoff had an alert, clicking on the schedule tab of a patient with an appointment caused 
the blockoff alert to be displayed. 
 

886 - Appointments Showing in Appointment Type Color 

If three appointments were made for the same doctor, at the same time, and one appointment has an 
appointment type selected; all three appointment would show the appointment type color. 
 
848 - Incorrect Option to Create a New Linked Appointment on Blockoff 

The “New Linked Appointment” option has been disabled on a blockoff. 
 

727 - Printing the Appointment Calendar Expanded Gives Extra Line Breaks After Last 

Appointment 

When printing the Appointment Calendar, and the advanced option "Print Expanded Schedule" was set to 
TRUE; an extra line break was being inserted after the last appointment listed for every increment rather 
than one an hour.  
 
722 - "Left Message" Icon Overlays "New Client" Icon in Appointment Calendar 

When an appointment is created for a new client, and the “Left Message” option is enabled, the “Left 
Message” icon will show to the right of the New Client icon. 
 

797 - Colon Shows in Place of Doctor Name in Out of Office Window 

In the Out of Office Schedule in the appointment calendar, inactive doctors showed a “:” in place of the 
doctor’s name. 
 
 

Boarding Calendar: 

3220 - Boarding Status Incorrect 

When a boarding reservation was checked out, the boarding status was incorrect in the information 
search. 
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789 - Unable to Create Boarding Reservation for "Existing" Client and "New" Patient 

Attempting to create a boarding reservation for an existing client and a new patient was causing the 
following message and the reservation ws not created: “Patient not selected. Please try again.” 
 
 
Client Area: 

2940 - Duplicate Phone Number Prompt Missing 

When the option "Referral Required To Complete Client Information" was set to True, clinics were not 
getting the following warning: “Client has same phone number as L'Heureux, Nicole, Account: 34.. 
Continue?” 
 
2890 - Client Birth Year Incorrect 

If a client's year of birth was before 1930, when entering in the client's DOB the year was incorrect.  For 
example, if a client born was born in 1919. When I enter 01-01-19 in the Client DOB field, the date is 
changed to 01-01-2019. The date should not be allowed to be in the future. 
 

2799 - Referral Required to Complete Client Information Not Working Correctly 

If Reuse Empty Accounts was set to True and Referral Required to Complete Client Information was set 
to true, users could add a client without choosing a referral. 
 
2043 - Error When Account Access is View Only 

In the Change User window, when “Client account Access” for an account was set to View Only, the 
following error was being displayed when the user tries to add a new Patient: "Access violation at address 
012A80E4 in module 'AVImark.exe'. Read of address 00000000".  Now users will only be presented with 
a message telling them they cannot add patients to their account. 
 

770 - Typing Invalid Character into Folder Number Field Finds All Clients 

If a numeric character was typed in the folder field on the CSD, all clients were being displayed.  Now the 
user will get a prompt that there is no match. 
 
1078 - Error After Import When New Client Added on Sidekick 

If a new client was added on the Sidekick, opening accounting on that client on the server was causing the 
following errors: “Attempt to read a record from CLIENTX.VM$ that doesn't exist.” Followed by: 
"Invalid Base64 Character" 
 
 

Estimates: 

1642 - Merge Words Not Working on Estimate Document 

The <appt-date> and <appt-doctor> merge words were not working on the estimate document. 
 
1079 - Floating Point Division by Zero Opening Estimates 

If the quantity of an entry on the estimate was set to 0, a fee was being charged on the entry and the entry 
had a variance; the following error was being displayed and the estimate was blank: "Floating point 
division by zero." 
 
864 - Canned Estimate Notes not Remaining Marked "Public" 

Upon choosing a canned estimate from within the "Change Patient Estimate" window;  the "Public" box 
for any notes attached to services was being unchecked. 
 
755 - Estimates - Cost Column Blank 

When the cost column is displayed in an estimate, the cost will now be correctly displayed. 
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751 - Estimates - Price Incorrect When Using Variance 

When using a variance and using the S or L action code the wrong price range was being displayed. 
 
2008 - Estimate Total Not Updating  

When checking Include Tax and Include Surcharge on a patient estimate, the total was not being updated 
appropriately. 
 

1391 - Assertion Failure in Estimate Window 

When the description of an entry on the estimate tab was changed, and the user clicked on the red X to 
close the window, the following error was displayed: "Assertion failure 
(E:\AVImark\Branches\2010.4.1\frameBrowseRecordList.pas, line 664)." 
 
 
EQ: 

3208 – EQ - Hoof Chart Showing Collected Date from 1990 

If a date is not entered in the Radiograph Date or Collected Date, the radiograph date and the collected 
date will now default to the current date. 
 
1618 – EQ - Equine Dental Chart Displaying Abnormalities by All Species  

The dental chart will only list the abnormalities that have the check box checked that says include on 
dental chart. Also the abnormalities will be limited to the species of the animal being shown on the chart. 
 
 

Follow Up List: 

1188 - Note Area on Follow-Up 

In the follow up window, expanding the window was not expanding the note area. 
 
3408 - Column Options Missing in Follow Up Window 

Some column options were missing in the follow up window. 
 
806 - Follow Ups Not Being Removed 

If a treatment that causes death is added to a patient’s medical history, the follow ups were not being 
removed until the user changed tab or manually refreshed AVImark. 
 
 
Information Search: 

3174 - Information Search: Searching for Specific SSN 

Searching for a specific Social Security Number, nothing was being reported. 
 

2699 - <number> Merge Word Not Working from Information Search 

Printing post card text from an information search, the merge word <number> was printing 0 for all 
clients. 
 

1447 - Dragging and Dropping Email Text Entering Blank Line 

On the Report Criteria tab, dragging and dropping the Client-Email-Text field was adding a blank line 
and nothing is reported. 
 
1313 - Searching for Reminder Template Treatment  

When searching in the Reminder Template Treatment area improper results were being reported. 
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1192 - Reminder Information Not Sorting As Before 

When exporting an information search to excel using reminder information as the format it was no longer 
sorting by the account number. 
 

726 - Information Search - OK Not Grayed Out in Code Editor 

The OK button will now be grayed out, in the code editor, until changes are made. 
 

724 - Information Search - Opening Code Editor Causes Search to be Re-Ran 

If a search has been run, and the code editor is opened, the search was forced to be rerun. 
 
621 - Dragging Report Criteria 

Users will now have the ability to drag and drop “Text” columns on the report criteria tab of the 
information search. 
 

620 - Need Shorter Column Width for File Name 

In the information search, the column width for file now will now default to 100 characters. 

 

611 - Entries on the Medical Condition Record Marked TODO Will Now be Searchable in 

Information Search 

 
608 - Search Window Closes if INF01 is Secured 

If INFO01 was secured, and an unauthorized user was logged into AVImark, upon attempting to open the 
information search the window would close. 
 

603 - Search Criteria Data now has Data to be Searched Upon 

 

600 - Error Closing CID While Search is Running 

If the CID was closed while an information search was running, the following error was displayed: Error. 
Record, Client, record number, 7440, record state, Loaded. Assertion failure 
(E:\AVImark\Branches\InfoSearch-5263\_btr\ubtrRecordIO.pas, line 425).  Now the user will not be 
allowed to close AVImark while an information search is running. 
 
589 - Information Search - Report Criteria Not Changing When Changing Search Criteria 

When an entry on the search criteria tab was removed; the report criteria was not being removed.  Now 
these entries on the report criteria will be highlighted in Red. 
 

615 - Errors Sending Email 

Attempting to send an email from an information search with the same merge word more than once in the 
message text, was causing the following error: "Access violation at address 2000679C in module 
'rtl100.bpl'. Read of address FFFFFFFC." 
 
 
Inventory List: 

3191 - Items Selected from Need List Being Placed on Purchase Order with Wrong Quantity 

When an item was placed on the need list with a quantity more than 1, it was not being put on the 
purchase order with the correct quantity. 
 
2956 - Cost on Need List Incorrect 

When an item was added to the need list, the cost was displaying incorrectly. 
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2761 - Unable to Select Quantity to Order 

When an item was added to the purchase order, and the quantity was changed in the selected area, the 
quantity on the purchase order was incorrect. 
 

2333 - Purchase Order Total Different When E-Mailed 

If a purchase order was e-mailed, the order total was not correct. 
 

2152 - Cost Being Changed on Item 

When receiving an item by right click receive from the purchase order, in some instances, the cost was 
being changed incorrectly. 
 
1781 - Error Attempting to Add Item to Receipting Order 

When attempting to add an item to a purchase order that is in Receipting status, the following warning 
was being displayed: “Cannot save due to the following errors: New Order Entry: File, 11030702.O2$, 
Order Entry has no associated Item. Associated Item Code is .” 
 

1702 - Purchase Order History Details Lists Wrong Heading 

The Pkg Cost column in the purchase order history window has now been changed to Unit Cost to 
correctly reflect the entry being shown. 
 
1601 - Unable to Drag and Drop to Selected Box 

When the item has been found by using the find field, the ability to drag and drop the item into the 
selected box has been restored. 
 

1526 - Inventory Variance Report Sort By Not Working 

When printing the inventory variance report, the sort options were not working. 
 
975 - Quantity Not Rounding Consistently 

The program was rounding inventory quantities differently in the program depending on where the item 
was selected from. 
 

809 - New Vendor not Accessible Until Closing and Reopening AVImark 

Upon creating a new Vendor in AVImark; this vendor was not able to be accessed from within the 
"Change Item" window until the program was closed and reopened. 
 
735 – Users Were Unable to go to Patient from "Change Item" WhoGot List 

 
731 - Canceling a Purchase Order "Return" Throws an Error 

Canceling a return from the purchase order history was causing the following error: “Error. Record, 
Purchase Order, record number, -1, record state, New. Destroying modified object.” 
 

730 - Access Violation Attempting to Print "WhoGot" List from "Change Item" Window 

Attempting to print the WhoGot from the change item window was causing the following error: “Access 
violation at address 00A7F27F in module 'AVImark.exe'. Read of address 00000294” 
 
721 - Right Click Another Not Copying Vendor 

If a vendor was selected on an item, and a new item is added by right click another, the vendor is not 
being copied. 
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649 - With Tax Column Not Being Updated When Closing 

When the Include Tax option was checked the charge column shows the price with tax.  When the 
inventory list was closed and reopened, the heading still said With Tax but the charge did not reflect tax 
 

3349 - Rounding Incorrect on Purchase Order 

When an item was placed on a purchase order the total was not being rounded, but when the purchase 
order was printed, the total was being rounded. 
 
 

Medical Condition Record: 

1635 - Doctors Notes Opening Instead of Recommendations 

In the Medical Condition Record, when reviewing the protocol of a diagnosis, the Doctor's Notes were 
opening instead of the recommendations. 
 

1291 - Subsystems Don't Show with Medical Condition Record Print Out until Closing and 

Reopening 

Attempting to immediately print the Medical Condition Record after checking body subsystems, was 
causing the body subsystem to not be displayed.  
 

1219 – Medical Condition Record Not Holding Weight and Temperature Values with 0 Decimal 

If a temperature or weight in the Medical Condition Record ended in a .0 (for example, 78.0) the .0 was 
being dropped. 
 
1210 - Problem Posted from Medical Condition Record Will Not Prompt for Document 

When a problem was set to prompt for a document, when the problem was placed in medical history the 
document was not being prompted. 
 
2578 - Entries Missing in Treatments Window of Plan Tab 

When logged in as a site clinic, choosing entries on the plan tab of the medical condition record was not 
listing anything. 
 

2274 - Repeat Not Holding 

When entering a repeat on an entry in the plan area of the medical condition record, the repeat was not 
holding. 
 
2166 - Declined Entries Not Marked Declined on Document 

Using the merge word <soap-therapeutic> on the report card and having a declined treatment and also 
have that same treatment not declined in the plan area, the document was printing the treatment twice but 
both were being marked declined on the report card. 
 
1101 - Obsolete Treatments/Items Showing in Choose Treatment/Item Window 

When selecting entries for the plan area of the Medical Condition Record window, obsolete 
treatments/items were also showing.  These will no longer be visible. 
 
827 - Pressing F2 from Assessment Area of Medical Condition Record Gives Blank Window and 

Access Violation 

Pressing F2 in the assessment area of the medical condition record was causing the following error: 
“Assertion failure (C:\AVImark\Branches\2008.2\_btr\ubtrUsage.PAS, line 145)”.  F2 will no longer do 
anything in the assessment area. 
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822 - Unable to "Arrow" Through List of Problems in Medical Condition Record 

Users will now be able to arrow through the list, press Enter to select the problem or double-click the 
problem with the mouse, or press Esc when arrowing through the list to cancel the search. 
 

783 - MED05 - Change Medical Condition Information is Not Working Correctly 

Securing MED05; was not allowing treatments to be chosen for a "New" Medical Condition Record.  
Now this function will only effect SOAP records that the user has clicked done on. 
 
3426 - Assessment Tab Not Updated 

When an entry was added to the assessment or plan tab of the Medical Condition Record and previous 
was clicked, the assessment/plan area was not being updated. 
 

1738 - Word Wrapping Incorrect on Report Card 

When including the <soap-abnormality-%> merge word on the report card, the word wrapping was 
following the notes window instead of the margins on the document. 
 
 
Medical History: 

1259 - Restore Normal Prices from Medical History Causes Error 

Using the option “Restore Normal Prices” from Medical History was causing the following error: "Error. 
Record, History, record number, 7411, record state, Modified. Destroying modified object." 
 
2017 - No Longer Getting Prompt Adding Item to Medical History 

When adding an item with a P action code and a quantity of 1 to medical history by right click choose, the 
following prompt will now be displayed: “Is the Quantity value, 1.00, correct for %?” 
 

820 - Unable to Apply Cost Plus Discount Over 100% 

Users will now be able to apply a cost plus discount of more than 100%. 
 

3135 - MED03 Secured, Drop-Down List Will be Grayed Out  

If MED03 was secured and an unauthorized user attempted to make a change to the medical history 
doctor the following error was displayed: "Error. Record, History, record number, 7760, record state, 
Modified.  Destroying modified object."  Now the doctor option will appear gray to an unauthorized user. 
 

 

Miscellaneous:  

1750 - Windows Being Cut Off In 800X600 

When using the screen resolution 800X600 some windows were being cut off. 
 

1298 - E-Travel Sheet WhoGot Gives Assertion Failure 

Opening the WhoGot from the E-Travel sheet was causing the following error: "Assertion failure 
(E:\AVImark\Branches\Alpha-Bugs\ETrvlSht.pas, line 1097)" 
 

954 - Rebuilding "Test Results" Gives Error 

Rebuilding test results was giving the following error: "File read error in file, ANLYTWP.VM$. 
Unexpected file size." 
 
3244 - eQuote Option Not Functioning and Generating Incorrect Warning 

Attempting to send an eQuote from an active patient or a line entry on an invoice, would cause the 
following error and the eQuote would not be submitted: “A new eQuote cannot be created because this 
client does not have any patients that are not marked inactive, deceased, or moved.” 
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753 - Arrows Were Pointing Opposite Direction of Which They are Navigating in Tests Window 

 
581 - AVImark Test Results Print Out Should Read "Patient" 

The AVImark test results print out was printing “Pet” instead of “Patient”. 
 
3089 - Forced to Use Note Annotation for Invoice Instructions 

If a patient had a note and the user attempted to enter invoice instructions, they would be forced to use 
note annotation. 
 
2977 - AVImark Allowing Empty Code to be Added 

Users will no longer be allowed to make an entry without a code in the item, treatment, diagnosis, and 
problem lists. 
 

2834 - Attachment Photos Not Saving in Correct Location 

If a jpg image was linked as an attachment, then reopened and saved, it was saving in the Photos directory 
instead of the Attachment directory. 
 
2827 - Searching in Advanced Options 

When searching in the advanced options, AVImark would search on each character typed.  This was 
making searching slow, especially on workstations. 
 
2596 - All Indexes Needing Rebuilt Are Not In Rebuild Message Prompt After Updating 

The indexes to rebuild after updating, was not always listing the correct indexes. 
 
2185 - Default Layout Missing in Dental Chart 

The default layout option was inadvertently removed from the dental chart.  This option has now been 
added back to the window.  
 

2018 - Preview Lines of Text Option Missing 

The preview lines of test option was missing in all windows. 
 
1376 - "Copied From" Not Copying Obsolete Entries 

When using the "Copied From" option, for site clinics, the obsolete entries were not being copied to the 
site database. 
 

1356 – Client Server Needs Lock to Keep Users from Calculating Patient Reminders at the Same 

Time 

A lock has been added to client server to keep users from entering reminders at the same time. 
 
1297 - "Appointment Type Entries" Category Has Been Removed from Advanced Options 

 
801 - Unable to View JPEG Attachments with New Image Editor 

When Advanced Option "Use Built-in Editor" was set to TRUE, and an "Attachment" with a photo of 
extension JPEG attached was opened; the following error was displayed: “Assertion failure 
(C:\AVImark\Branches\2009.1\_avi\uOrganizedFile.pas, line 287)” 
 
773 - <serv> Merge Words Not Working When Using Shift+Spacebar Command Keys 

The merge words <serv-doctorname>, <serv-description> and <serv-doctor> were not working when 
using the Shift + spacebar keys to merge information into a notes window. 
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1546 – The Detailed Error Log Was Showing the Incorrect Database Version 

 

879 - Error Printing Document with ^ Symbol 

The the ^ symbol was included on a document, when the document was printed the following error was 
displayed: "OLE error 800A15F8" 
 
2869 - Care Credit ‘Instant Client Application’ Option Was Not Filling in Client Information 

 
3530 - Signature Line on Debit Payment Invoice 

When a debit payment is taken, the AVImark Invoice will no longer display a signature line. 
 
2973 - Access Violation in Advanced Options 

Clicking edit… undo or edit… redo, in advanced options was causing the following error: "Access 
violation at address 00D07A84 in module 'AVImark.exe'. Read of address 000002F0." 
 
2979 - CTRL+UP Not Working in Client Server 

Highlighting in the client area and hitting CTRL+UP keys will now move between clients by name in 
classic and client server. 
 

3134 - CTRL+Down Skipping Down Two Records in Client Server 

Highlighting in the client area and pressing CTRL+Down was skipping two records in client server. 
 
2970 - Access Violation Generating Shot Requests when Using Windows Colors 

When “Use Windows Colors” was set to true; upon attempting to create an IDEXX PACS request users 
were presented with Access Violations. 
 
 
MPS: 

2777 - Misspelling in MPS Warning 

When taking a credit card payment, then canceling the swipe window, the word ‘Processing’ was 
misspelled in the warning message.   
 
3189 - Authorization Window  

The Authorization Window should come up as soon as you click Done after changing the payment type, 
instead of allowing it to go all the way through before giving the warning, “You are not authorized”.    
 

2354 - Hand Keying When Processing Card Will Allow Invalid Year to be Used 

The year field now has a check in place to verify correct format before it attempts to process a card. 
 

1756 - Ticket Tape Used for MPS receipt 

When logged in as a site clinic and using MPS the receipt will now print the site clinics information. 
 
 

Patient Area: 

2281 - Able to Enter Deceased Date Without Deceased Action Code 

Users will no longer be able to enter a deceased date for a patient without also entering the deceased 
action code. 
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2151 - Age Wrong on Patient Chart When Unknown is Checked 

If "unknown" was checked for the patient's birthday and no date was entered, when printing the patient 
chart 110Y was printing for the age.  Now if unknown is checked and no birthday is entered, unknown 
prints on the chart for the birthday and the age. If unknown is checked and a birthday is entered, the date 
will print on the chart with unknown next to the date. 
 
838 - Upon Removing Entry that Causes "Deceased" Status; the Deceased Date was not Removed. 

 
1627 - Referral Not Printing on Chart 

If a referral selection was setup in system tables and the description was longer than 20 characters; the 
referral was not being included in the referral options. 
 

815 - Searching for Patient Names Longer Than 10 Characters Will Not Find Every Patient 

When searching for a patient by name; names longer than 10 characters were not all being displayed. 
 
762 - Adding a Breed/Color to a New Patient 

Typing in a breed or color when adding a new patient, appeared to add the breed or color to the patient, 
but upon clicking done, the breed or color would be changed to a different selection from the existing list.  
Now the breed or color will be changed to unspecified. 
 
 

Reminders: 

813 - Reminder Templates Cut Off 8th Character in Treatment Code 

All eight characters will be visible on the reminder templates. 
 
3014 - Error Using Reminder Wizard 

Clicking on the Wizard in the reminder template was causing the following error: "Invalid class typecast.” 
 
2671 - Issue Moving Remindable Services 

Moving a remindable service from one patient to another was not updating the reminders correctly. 
 

1972 - Error Running RatingClients Utility 

When attempting to run the RatingClients utility in some databases, the following message was being 
displayed: “'0000-53975' is not a valid integer value.” 
 
3365 - Multiply Interval by Quantity Sold Not Updating Correctly 

If the option to Multiply Interval by Quantity Sold was checked on a reminder template and a code was 
set to remind as this reminder and the quantity sold was changed after being added to history, the 
reminder due date was not updating correctly. 
 
 

Reports: 

904 - Object Has No Title When Running Some of the Practice Analysis Graphs 

When running the practice analysis graph for New Client, New Patient, Total Charges, or Total Payments 
and graphing through Excel, the following error was being displayed: "This object has no title" 
 
Note: Graphs cannot be shown in Excel by Day, Week or Month. 
 

2514 - Tax Incorrect on Period Totals 

The tax amount on period totals report was incorrect, if an open invoice was created following a day 
without accounting. 
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881 - Unposted Transaction Report not Reporting Unposted Entries 

Entries entered into medical history with a future date will now be reported on the unposted transaction 
report. 
 

760 - Inventory Used Report Cannot be Saved 

Users will now be able to save the inventory used report to be printed automatically for a selected period. 
 

2278 - Referral Letters Printing for All Referrals 

When referral letters were printed, they were being printed for all referrals, including referrals from 
system tables.  Now only client referrals will be printed. 
 
984 - Error Running Income by Provider 

When a treatment or item was added at the site clinic but not at the home clinic, running the income by 
provider report would cause the following error: "Error. Record, Item, record number, -1, record state, 
Unknown. Record is deleted. Attempt to load invalid record number." 
 
 
Sidekick: 

943 – Sidekick - Option to Update Controlled Substance Does Not Remember Last Setting 

Update inventory quantities during import" & "Update controlled substance quantities during import" will 
remember whatever the setting was during the last import. 
 
 
SQL: 

2870 – SQL - Connection not Open Error when Clicking AVImark Icon on Tool Bar  

 

2634 – SQL - Invoice Relisting Each Line as Payment Received  

When printing an invoice, the entries were being listed a second time as a payment. 
 

2021 – SQL - Error Running Search Looking for Patient Relations 

Searching for patient relations was causing the following error: "The multi-part identifier 
"RelationEntry._Recno" could not be bound." 
 
2007 – SQL - Unable to Drag and Drop in Associated Entries Window 

 

1888 – SQL - "Reuse Empty Accounts" was not Working in SQL 

 

1591 – SQL - Information Search Error 

Searching for Client Full Name is not Blank was causing the following error: “Error, The data types text 
and varchar are incompatible in the not equal to operator..SELECT "Client"."_Recno" AS RCol0, CAST) 
AS Col0 FROM Client LEFT OUTER JOIN "##TempClient" ON "Client"."_Recno" = 
"##TempClient"."_Recno" WHERE "Client"."_Active" = :Client__Active000 AND 
("##TempClient"."FullName" <> :TempClient_FullName000)” 
 
1405 – SQL - Need List Slow 

When building a Need List for all vendors, it was slow in SQL. 

 

1401 – SQL - Audit Trail Report is Slow 

The Audit Trail Report was Slow in SQL. 
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867 – SQL - Information Search - Dragging Report Criteria 

Users will now have the ability to drag and drop “Text” columns on the report criteria tab of the 
information search. 
 

643 – SQL - Information Search - Errors When Trying to View Notes 

If notes were setup before changing to SQL, the following error was displayed when printing the search 
criteria: “Error. Record, Search CriteriaWP, record number, 2490, record state, Loaded. Record is deleted. 
Record, 2490 not found.” 
 

3307 – SQL – RevSys Utility Was Not Working 

 
2999 – SQL - Adding New Breed Entry or Removing Breed Entry Gives Errors 

In some databases, removing a breed entry caused the following error: "Invalid column name 
'BreedSpeciesCode'." 
 
3270 – SQL - Code not Reminding for Itself Until Right Click Defaults 

When a service was set to remind as itself and another code, the reminder if itself was not being generated 
until the users preformed a right click defaults. 
635 – SQL - Information Search Searching for Account Category 

Searching for Account Category was causing the following error: “Invalid class typecast." 
 

 

Statements: 

1696 - Period Summary Overlapping Aged Accounting on Statements 

When printing statements, in some cases, the Period Summary was overlapping the Aged Accounting. 
 
 
System Tables: 

1299 - Color Table Loses "Color" Column when Updating 

In some instances, updating was causing the Color table color column to be removed. 
 

1984 - Variance Reasons--Allowed to Enter a Code with More Characters than Allowed 

Users will only be allowed to enter a variance reason in system tables with 1 alpha or numeric character. 
 

814 - Creating New Discount Class Does not Automatically Set Code Correctly 

Discount classes will now work with single digit codes. 
 
861 - Sales Summary Report Incorrect 

The sales summary report will now print by the admitting doctor instead of the providing doctor. 
 
 

Time Clock: 

3184 - Time Card Report Incorrect when Printed by Reason 

If the time clock report was printed by reason, the hours were not correct. 
 
1690 - Printing Time Card "Summary" Report Includes an Extra Blank Page 

Printing the Time Card report with "Summary Report" checked; was printing an extra blank page. 
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Treatments: 

1736 - No Longer Displaying Markup Not Preformed Message 

Upon canceling the Markup Treatment Prices window, the “Markup not Performed” message was no 
longer being displayed. 
 
756 - Compliance Tracking Action Code 

The compliance tracking action code (]) has been removed from treatments and items. 
 
745 - Correct Group Price was not Consistent in Treatment List When Selecting Treatment First 

 
741 - Two Entries Highlighted When Attempting to Select a Treatment 

In some instances, depending on the order of treatments and what was listed upon entering the Treatment 
list window; two entries were automatically highlighted when using "FIND" window. 
 
 
Utilities:  

3234 - KASPER Utility Needs Removed 

The KASPER utility has been removed from AVImark, it has been replaced with ASAP. 
 

3429 - ChangeCode Causing Errors Consolidating Codes 

The ChangeCode will now work correctly to consolidate codes. 
 
964 - "Invalid Record" Error Upon Attempting to Run Znote in a Database with Corrupt Doctor's 

Instructions on Deleted Entries 

Attempting to run the ZNOTE utility on a database with corrupted doctor’s instructions was causing the 
following error: “Error. Record, History, record number, 101914, record state, Deleted. Record is deleted. 
Invalid record state during PropertyChanging.” 
 
1972 - Error Running RatingClients Utility 

When attempting to run the RatingClients utility in some databases, the following message was being 
displayed: “'0000-53975' is not a valid integer value.” 
 
3754 - CopyAVImarkFiles Duplicating Reminder Templates 

When CopyAVImarkFiles was run, the reminder templates were being duplicated in the target data. 
 
3752 - CopyAVImarkFiles Not Copying All System Tables 

The CopyAVImarkFiles utility was not copying all the system tables entries. 
 
3543 – CopyAVImarkFiles Search Criteria Copy Option Fails   

When running CopyAVImarkFiles, the search criteria was not being imported from the source data. 
 

1143 - Remove Utility Was Not Removing Balance Brought Forward 

 
 
Whiteboard: 

834 - Whiteboard Option "View "(All)" Users By Default" Does not Work Correctly 

If the option "View "(All)" Users By Default" is set to True, the Whiteboard...Schedule Tab will default 
to (all). 
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2897 - Error Sending DelPrt to Excel 

Attempting to run the DelPrt utility and sending the results to Excel was causing the following error: "List 
index out of bounds (8)." 
 
 
Work List: 

908 - Work List Entry Removal not Being Included in "Entry History" 

When a work list entry is removed, the removal will now be included in entry history. 
 

795 - Notes Showing Incorrectly for Declined Work-List Entry 

When Advanced Option "Allow Multiple Work List Entries Per Patient" was set to TRUE; declining a 
medical history entry that added an entry to the work list, the wrong notes were printing when the work 
list was printed.  This fix will only work with future entries; past entries will still print incorrectly. 
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2012.1.2.0 Fixes List 
 

3865 - 9 Action Code Charging Tax by Package Cost Not Item Cost 

The 9 action code was causing tax to be charged on the package cost, instead of the item cost. 
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2012.1.3.0 Fixes List 
 

3921 - Changing Medical History Changes Reminder Due Dates 

When any change was made to a medical history entry, the reminder tab acted as if a right click defaults 

was performed. This was removing patient specific reminders and suspended reminders. 

 

3899 – SQL - Unable to Mark a Patient Deceased 

When double left-clicking in the “Deceased” field of patient information on CID screen; the following 

error was displayed: "Cannot focus a disabled or invisible window". 

 

3898 - Backdating Accounting Causes Entires to be on Wrong Invoice 

If accounting was backdated, these backdated entries were being put on the prior invoice, instead of 

creating their own invoice. 
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2012.1.4.0 Fixes List 
 

4095 - Pick List Deducting Duplicates from On Hand 

When using the pick list, a duplicate amount was being deducted from the on hand. 
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2012.1.5.0 Fixes List 
 

4071 - Using Same As Not Working Correctly 

When using the Same As option for site, the inventory list was not being displayed correctly. 
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